Eduphoria Basic Features
Forethought

Forethought allows you to copy lesson plans with a variety of options. When you copy the
following ways, it will copy Learning Standards, text and Attachments.

Here are the ways you can copy lesson plans:

Individual Planner
 Copy from daily entry to a daily entry (same course) using Send Lesson To button
« Copy from day to day or week to week in Copy Wizard from week view

Shared Planner (teacher to teacher)

» Copy entry from shared to individual (same course) using Send Lesson To button

« Copy entire week from shared to individual (matching like courses) using Copy Week in week
view

» Copy day or week from shared to individual (matching like courses) using Copy Wizard in week
view

Team Planner

 Copy entry from team to individual (same course) using Send Lesson To button

« Copy entire week from team to individual (matching like courses) using Copy Week in week view
» Copy day or week from team to individual (matching like courses) using Copy Wizard in week
view

» Copy days or weeks from year to year within Team Planner using Copy Wizard in week view

What can you not do?

¢ Copy from individual to a shared

e Copy from individual to a team

¢ Copy from within the same year in a team

* NEVER edit a shared planner - only edit your individual or team

Send Lesson To: This function allows you to copy an entry to another entry. Make sure you save
your lesson plans before you

copy. Select the Send Lesson To = o
button in the entry blue-gray - i
box. Choose a target date from e e e *@ T
h 1 d h l h Select a day from the calendar below:
the calendar, then select the ch fer
’ < October2011  >| [Ty thematics Grade 4
course that matches the original Warm-up: i e s
entry by checking the box. Then Ll L
click OK. This will append the Hateriale R
entry to the target entry's plans. ok_| [ close |
Copying Lesson Plans: The Procedures:
Forethought lesson planner
gives you the flexibility to copy
individual lessons, a day's oo =
lesson plans or even an entire
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Note: Plans must be in Week View to see the Copy
Wizard. The copy and move wizard gives you the ability
to copy plans within your planner and shift plans
from a specified date.

Copy Wizard Options
* Copy Content Select an option to copy or move:
 Copy instructional days from year to year (®) Copy content in my planner

* Shift lesson plans a day O Copy instructional days from year-to-year

Copy Content ) shift lesson plans a day
1. Choose to copy content for an entire day or week.
2. Select the day or week to be copied

3. Select the destination day or week to copy content.
4. Confirm your selections and click Finish.

Notes regarding copying:

¢ If no lesson structure exists for that date, the first schedule in your list will be used.

» Lessons of the same course will be copied in the order they appear in the target date. Additional
plans will not be automatically entered. For example, if you have two U.S. History plans in the
source planner and only one in the target date, only the first will be copied. The second will not be
added.

» Content will be added to any existing lessons (appended) that exist in the target dates or weeks.
e There is no "undo"” when you copy lessons.

Shift Lesson Plans a Day: For occasions such as an inclement weather day or an unexpected event,
lesson plans can be shifted ahead one day. Shifting lesson plans will move all content up one day
from the day selected to the end of the instructional year. Note: If any content on the last day of the
instructional year exists, it will be removed.

Creating a New TEAM vs. SHARING a Planner

Scenario: | want to able to share my lesson plans with others. How do [ do that? Do I create a Team
Planner or do I simply Share My Planner with other teachers?
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A Few Items to Consider When Creating a TEAM PLANNER
¢ A Team Planner creates one plan that can be edited by all members of team at any given time. The
goal is to allow the team to complete the entire week’s plans and then copy them back into each

individual’s planner template.

» Teams can be created by any teacher, but only ONE person on your team should create the team.
¢ Teams are collaborative and there is no "Team Leader".
¢ Team members can be added and removed by any member of the team.

Step 1: Creating a new team:
1. Click the Create a New
Team button at the bottom of
your planner

2. The Create a New Team
wizard will appear

3. Click the Next button

4. Enter a distinctive name for
the team

5. Click the Next button to add
team members

Step 2: Adding team
members:

1. Click the Add a Member
button

2. Enter the teacher’s name or
email address (first or last
names only may be entered as
well)

3. Select the member from the
returned results (if only one
teacher is found, they will be
automatically added)

4. Repeat this process until all
members have been added

5. Click the Next button to add
courses to the team

Step 3: Adding team courses:
1. Click the Add a Course
button

2. Navigate the course tree and
select a course

3. Click the Next button to add
the course

4. Repeat this process until all
courses for the team have been
added

A Few Items to Consider When SHARING YOUR PLANNER
¢ You should choose Share My Planner if you would like for a specified teacher to view your plans
(but not change them). (Ex: You are a PIP/mentor teacher, department chair, etc.)

Share My Planner

Planner Dptions L

NOTE: Teachers don’t have to share their planner with the
principal/AP because they are already able to view teacher
plans for their campus.

& Create a New Team  [75) My Schedules
Change My Settings [=] My Flanner Template

1. Click Change My Settings (bottom left) o
2. Click Share My Planner < August 2007 >

. s M T W T F s
3. Click Add a Teacher i 7z 3 4
4. Enter the last name of the teacher S 6 7 8 9 10 11
5. If there is more than one teacher with that last name, click that 1z 13 14 15 16 17 18

19 20
26 27

21 22 23 24 5
28 29 30 31

teacher’s name to select it

6. Click Next

7. Continue clicking Add a Teacher until you have selected each teacher
8. Then, click Next

9. Click Return to My Planner

My Lesson Plans

L& My Lesson Planner

Lo 1avy Tillis's Planner
o orade Level Team Planner

NOTE:

The selected teachers will see your name on the left side under My Planner.
They can click your planner name and view your plans.

They cannot make any changes in their planner.
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Anatyre

Shudents.

AWARE

Viewing Data

Although primarily oriented towards teachers, this section covers the fundamentals of viewing data
that applies to all users regardless of access level. The base elements of the teacher interface are
repeated in the Principal and Administrators interface.

For teachers, Aware's primary function is to provide a friendly interface to view and drill down into
TAKS and benchmark data. In fact, the first screen that teachers will see when entering the
application is the Analyze tab.

"ehodObjecdWaAINE B Suich sopicarons ~ @ Heo | ) Log ol

Benchmark Alert 1 Export to Exoel Student Scores w) Ethiaty & Gender | [ Charts

) Benchmark Available . . .

< @754 This tab will show you a list

e th Grade Hoth - rcb 07 of the classes you teach on

i ‘;i"_ _:; i TotalStudents  BawScore  Percentile Score Het Expestatsams, .

M e ie N the left pane. Each course is
& MATH (20H0.-06) eduphanal Elementary 55 58 EI% 0% 0.91%

.. '-3} LU::S:v-—.::s A5 PasAs Islander 1 773 73  BLEMS 1. 15% eXpandable to allOW you to

5 B My Sadent Grone Pste Mot Hsparse ® 827 % I% A%

view the specific TAKS or

Bk 8 &3 5.5% FE 5%

nndd C ! o) 2 benchmark information for
Male 1 8.8 aL.82% gres% 212%
Ferae = 76 R Y that course. If a course has

benchmark or TAKS data, that
can also be expanded to view
a specific test. Selecting a
- . benchmark or TAKS test will
Sl i bring you into the main data
view for that test.

5 Create a Moriinr Ust

Changing Views

There are four main data views for teachers. You can charge between the main data views using the
drop down list on the very top toolbar. This will allow you to change between:

« Student Scores

 Student Objective Breakdown
« Student SE Breakdown
 Student Individual Responses

When a view has been selected, you will see the columns of data change accordingly. This is the first
level data filtering that teachers can adjust.

Note: Do not use the back, forward or refresh options on your browser. Use the back, forward and
refresh | & o | buttons that are available in Eduphoria Aware.

=
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Changing Levels

In addition to this, you can adjust the scope of the data. To the right of the view title are four small
buttons entitled Level.

[ Export b0 Excel Shudent Scones w) Efvacity & Gender ~| [& Chwr

= @748
These options will allow

Hh Sredalisth- Feb &7 you to change between:

Total Stsdents Flaw Soore Fercentile Soore HMet Expectations 1

Yes W |

edupborial flementary 55 758 WA 09.09%  10.91% | District Summary
PSS — 1 .7 7.I% BLETR 15.13%
it Hiat Pezpars Y a3 BLiO%  S23i% 74% Campus Summary
Bk 8 7.6 %.25% % % Teacher Summary
Hispan w0 780 % 1% 0% Individual Students
M ' 13 8.18 BLEI%  SLES% ILLD%
Farae z 7.68 W% W% SN

Campus
Summary

Teacher
Surmrmary

Individual
Student

As you change the level option, you will see the left side of the data view change accordingly.
Depending on the level, you may see the columns change somewhat as well. The data can easily be
sorted by column by simply clicking on a column header. Clicking again will sort the column in
reverse order. This can be used to easily sort the data by whatever field you may be looking for.

Drilling Deeper

Changing view and level are the two primary ways to filter your data. Once the information has
been filtered using those options, you can then drill down into the data by double clicking on a row
header on the left side. For instance, when looking at the campus level, you can double click on the
female row header. This will show you all of your female students' data for that test.

4 Expeart b Bl Sudert Scones | Ethwacity B Gender | (&) Charts i ThlS data can then be
o 2738 | sorted by column as
i before. Drilling down
Student Hame local  Cthicity Campushame  Gender Raw Percentle  Met | into a particular student
b1 ] SCoEe SCore Expectations
StudertS 12, Damans DBEYS  Whits Mot Mspanic echphorial Blemertary  Feoals ] B Tes will take you to that
Shudentd513, A} OBARTS \White Pt Hisparee  ecduphonal Blemerviary  Fesals b1+] 100 s student's information.
Shuden 3686, Lucers =05 Henaret  eduphoria! Blemeriary  Fesals Ll =% L] .. .
StudentiTS6, Adelade ta 1807 Bisck ecuphonal emertary  Feale 5 % ha | This is covered in the
ShudentdT7, Paukne 092275 AsienPaclc ilinder  ediphorial ementary Fomale | 7 %% Yes next section.
Student3a5s, Madson (9570 Whae biotHaerkc  ecuohorial Blemeniary | Fesale | 7 % e
StudentEITL, Karna (SIS0 When biotHsarkc echphorial Blemeriary  Fesale | 6 0% Ho
Student¥577, Bela N3 Hispanic ecuphorial Bementary  Femaie | 9 % Tes
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Charting

Once you have used the views, levels, and drilling to find the data you are looking for, you can then
chart that information. Simply select Charts in the upper right of the main toolbar, and then you
can click on a particular column to chart that information.

H Export bo Excel | Saudentt Scores wj Efricity & Gender v | Chart Viewer In this example, the Met
o Expectations: Yes
% & @2Tae column was chosen for
- L :
T - ethnicity. The charting
cprily il ety Has tools then drew a column
Fafasts Somrn. - Soern i’““‘“’”: for each ethnicity. To get
(=1 L % .
eduphorial Elementary 55 79 TRECYS B9.09% 10HI% a larger Vlew’ you can
Asian Faofic slander 11 773 7RIT% I BLACW 18.18% select View Lal‘ge on the
Wt Fet Hsgars: B ST BLER% LM% 7% | an, charting toolbar. The
Black 8 768 maw [pw 1% larger view also has a
o ! M O W < | print option will which
tale R BT LEMG | A788% 1213% | 0%
2 o Ml e allow you to send that
Femals 3 TER A% S051% 9.09% . . .
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T to a printer.
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= 5
] =
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Exporting

The last option on the main toolbar is Export to Excel. As you would imagine, this option will send
whatever information you may be looking at to Excel.

Benchmark Tests

This section assumes that teachers will be scanning their own tests.
However, Data Administrators can print and scan in answer

Benchmark Alert

k] =
documents as well. The printing process is covered in the section % O Benchmark Available
For Admins: Benchmarking, however the scanning process is &

. . My Students and Classes
identical and can be referenced here. h
Lo & 4LANGUAGE ARTS (104
Printing Answer Documents a -
= e 4 CITIZENSHIP (2940-05
: . LZ E
Aware makes it very easy for teachers to administer a benchmark 2 & 4 SCIENCE (3040-05)

test. If your district is not using Forethought, then you will have to

4 S0OCIAL STUDIE (4040-
check in the Aware application for any available benchmark tests. - E

& 4MATH (2040-08)
When entering the application you will see this notification: -

[+

+

If your district is using Forethought, you will see this notification
when entering that application:
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Regardless of which application you use, clicking on the
Benchmark Available notification will show you a list of all
available benchmarks.

Select 8 section fiom your rosber print anewer documents for the bendhmark: et

@ [Pt ]

In this example, you can see that a 4th grade mathematics
benchmark is available. This teacher can click on Print to create an
Adobe Acrobat file of the student answer documents. These answer
documents can then be printed to any printer, but a clear laser
printer is recommended for the best scanning results. You will
send all benchmark tests to the copy machine in the front
office. Make sure you select ‘secure’ print.
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D Benchmark Available

My Lesson Plans

LF My Lesson Planner

T F 5
4 5 6
11 12 1
18 19 20
25 26 7

dth Grade Math - Feb 07 [4 MATH: Penod 5]

Hame: Student3471, Cody Teacher: Garmetl, Chastily Date: 17292007
. @E®&@6e6 3 &@aee6@ 5 @aeea6 7 @aee@ 9 L ® @ @
e D EEGE 4 DEAE 6 DEEE@ 8 Be g 1 I RRCVIR )

Each answer document will show the student's name, teacher's name, and the current date. The top
of the document will show the particular test and the section for that teacher. The bottom of the test

tells Aware how to identify that particular test.

Monitor Lists
Create a Momitos List

Monitor Lists are groups of students that can

be Created to allow teachers and Other Staff Manitor lists allow  teacher to view grades and attendance information for a group of students. For instance

iy . . &9 a UL teacher could manitor students to make sure they're not in jeopardy of failing. Special Education
the ab]l]ty to monitor Spec]f]c students. For teachers can also use this feature to manitor At Risk sudents.
eXample, an ESL teacher C()uld monitor the ¥ you have already created a monitor list and would ke to edt 1t Click Hare,

progress of ESL students in their classes.
These Monitor Lists are created by the
teachers and staff themselves and then
approved by their Principals.

Monitor lists are also used to view the
profiles for select students easily. The My
Student Groups option on the Analyze tab
will show your monitor lists for quick
viewing, and they are used to search for
students on the Students tab.
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Creating Monitor Lists

To create a monitor list, click on Create a Monitor List
in the bottom left corner of the main Aware interface
or Analyze tab. This option will launch a wizard
allowing you to create and populate your monitor list.
If you have already created a monitor list, you can click

Create a Monitor List

mnic?
dImpuUss

Select the campus for this list. A monitor list can only be created for a specific campus.

Campus:
aduphoral Elsmentary |+

on Click Here to view your list(s).

Clicking Next in the wizard will allow you to start
creating your list. First you will need to choose the

campus the list is for. You can only monitor students

from yours campus(es).

Once a campus is chosen, you will then need to
create a name and description for the monitor
list. The description is optional, but it may help in
identifying it later.

Click Next > to continue,

[cancer) (= ok (et )

Create a Monitor List

Select a name for this list. The name should be distinctive so it's easily recognized.

Monitor list name:
UL Reading Team

Description:
The 4th grade UL Reacing toam members |

Chck Next > to continue.,

Create a Monitor List

Finally, you can complete the list by

searching for students. Simply enter a name,
student ID, or course code into the search
box. Remember that spaces are not allowed.
Click on Search, and you will see a list of
students that meet your search criteria. You
can then select the correct student and click
Add. Repeating this process will allow you to
build a list of students in the right list. Once
completed, click Next and then Finish. Your
monitor list will be created and your
principal and can now review it.

Here you can added either an entire class, or individual students to the monitor list. Te add & dass you will need the
course and section number aleng with the campus. You will not see the students who are enrolled until after the monitor
list has been approved. To add indiviual students, just search for them by name. Select the students from the list and
click the add button.

Student Name or 1D Number or Course

ol Monitor List Students and Classes:

studentBi3 » -
— Add > StudantEa38, Tyler (092471

Chck Nt > to continue,

Cancei
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wh Add a Monitor List il Edit Selected Ust  JI Delete x

Bedow are all of your monitor kts, Yol can add and remeve students 1o the Bts, o delete them if they are no longer nesded,

5 Varsity Golf Team (Pending Approval)

m UIL Reading Team (Pending Approval)

You can click back on Create a Monitor List and then click on Click Here (as mentioned above) to
review or edit your monitor lists. Use the Add a Monitor List here to create another list, just as you
did above. Or you can click on a particular list and select Edit Selected List to go back through the
wizard and make changes to an existing list. Lastly, you can select a list and click Delete to remove
a list you may not need any longer.
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